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Studying this manual and attending the basic training does NOT constitute 
an individual as certified to testify.

Cell analysis is a great investigative tool.  However, testifying in court 
regarding cell phone records is difficult and requires significant training.  
Prior to testifying, CAST agents receive over 500 hours of training.

Disclaimer
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• CAST brings unique expertise to cases in which cellular telephone information serves an important 
evidentiary role in the investigation.  When necessary, CAST will utilize industry standard survey gear 
drive test equipment to determine the true geographical coverage breadth of a cell site sector. 

Project Pin Point (PPP) uses the following data sets…

• Historical cell tower lists

• FBI Informants and liaison contacts (Community Outreach, etc.)

• Fugitive Warrant data and Megan’s Law Sex Offender registry

• Other divisional crime data such as shootings, robberies, etc.

• Other data deemed appropriate such as visas, cameras, case information, etc. (i.e. DIVRT)

… Which are overlaid and analyzed using mapping software to support:

• Fugitive apprehension

• Informant development

• Enhancement of investigations for all investigative programs

***To obtain CAST services, e-mail cast@fbi.gov. An intake form link will be provided. After 
submitting this form, a CAST asset will be assigned your case.
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The mission of the Cellular Analysis Survey Team (CAST) Program is to support FBI,
along with state, local, and tribal investigations through the analysis of cellular call detail
records (CDRs) and their associated tower information.

Priorities:
1. An immediate threat to life.
2. FBI priorities, to include National Security, Criminal, and Cyber.
3. Assistance to state, local, and other federal agencies.

The CAST Program is managed by the CAST Unit within the Operational Support Section
of the Criminal Investigation Division (CID) with 5 HQ SSA’s and 15 “National Assets,”
who are CID assigned Special Agents embedded within selected field offices.

The program also has over 50 CAST certified “Field Assets” who provide CAST analysis
within their respective field offices.
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CAST Mission & Structure

Mission

Structure

Mission
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Required Training for CAST Certification

Stage 1:
Basic Historical Cell Site Analysis Course

Stage 2:
CAST Geo-Location Course

CAST FTX Course
Instructor Development Course

Advanced Historical Cell Site Analysis Course

Stage 3:
CAST Certification-

4 Weeks

Process takes 18-24 months

On-the-job Training: 
Current members work 

continuously with candidates on 
cases to increase their exposure 

and experience.
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PRODUCTS &

CAST National & Field Asset
Responsibilities

 Obtaining and analyzing cellular communication data

 Historical CDR analysis and geospatial mapping 

 Tower dump analysis and comparisons to establish links between significant      

locations/persons and cellular tower data

 Drive tests aid in verifying and measuring the actual coverage area of a cell tower

 Target Acquisition through the analysis of CDRs facilitates the deployment of a 

Wireless Identification and Direction-finding Team (WIDT) 

 Expert Witness Testimony in support of cellular analysis
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To request CAST assistance with a 
case, email CAST@fbi.gov and 
request the CAST Intake Form.  

Fill out the form, and a CAST 
agent will be in touch with you.

CAST Intake Form
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• Title 18, United States Code § 2510 (15) - Definition of electronic communication provider

• Title 18, United States Code § 2701 - Electronic Communication Privacy Act (ECPA)

• Title 18, United States Code § 2702(c) - Voluntary disclosure by provider of information/records pursuant to an 
exigent request

• Title 18, United States Code § 3125 - Emergency pen register and trap and trace installation

• Title 18, United States Code § 3127 - Defines electronic communications, pen registers, wire communication, 
electronic communication, electronic communication service, and contents

• 28 CFR Part 16 Subpart B - Production or disclosure in federal or state proceedings regarding law enforcement 
information

• Court Orders/Search Warrants

• Court order 2703(d) or search warrant for historical call detail and cell site. Refer to the AUSA for the most 
current court requirement.

• Court order 2703(d) & 3123 hybrid order for pen register to also get historical records may require a search 
warrant

• Policies

• The best policy is to discuss with your local AUSA and determine what method (2703(d) or search warrant) 
should be pursued in order to acquire the records from the cell phone company.

US Codes & Orders
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General Record Request Requirements
Varies by Judicial District

Subpoena

• Toll Records (no cell sites)

• Call to Destination search

• Subscriber information

• Payment Information (i.e. how 
payment is made)

• ESN (electronic serial number)/IP 
Addresses

• How long the subscriber has had the 
service and phone equipment

Court Order or Search Warrant

• Historical Tower Information to include cell 
site and sector

• Text Messaging /Text Content

• Data Connections

• Installation of Pen Trap & Trace

• Tracking authorization

• Subscribers for all numbers contacting target

• Location Based Services

• Ping data (Sprint)

• E-911 (T-Mobile & AT&T)

• Plus: Anything you can get with a Subpoena 
alone
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PRODUCTS &

Language for Historical CDRs with Cell Site
and Additional Reports (Carrier Specific) 

VERIZON:
Provide Call Detail Records (CDRs) for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:

All subscriber information, including name, address, contact numbers, activation/deactivation dates, account number, social security

number, and account features

1. All device identifiers, to include ESN, MEID, IMEI, and IMSI

2. Cell site locations and sectors for all outgoing and incoming voice, SMS, MMS, and Data transactions.

3. All available RTT reports, to include 1X, EVDO, LTE, and data.

4. IP Session and IP Source-Destination reports

5. All text message content to include pictures OR provide the Cloud account which stores this content. (Requires Search Warrant)

6. Device identifiers, such as IMEI, for all devices (watches, HUM, tablets, etc.) that are connected/paired to this number/subscriber acct.

Voicemail retrieval is available (requires order to be a Search Warrant). A request must be made for Verizon to reset the Subscriber’s 

password, then the investigator can access the Subscriber’s voicemail. ***CAVEAT: THE SUBSCRIBER WILL KNOW THE PASSWORD HAS 

BEEN RESET***

SPRINT:

Provide Call Detail Records (CDRs) for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:

1. All subscriber info, including name, address, contact numbers, activation/deactivation dates, account number, SSN and account 

features

2. Cell site locations and sectors for all outgoing and incoming voice, SMS, MMS, and Data transactions.

3. All available PCMD reports, to include LTE, EVDO, IP session and data.

4. All available voicemails (Requires Search Warrant)

***Recommend at least 60 days worth of records in order to establish a pattern analysis. 
See below for suggested language to obtain this time frame*** 

Last Update 08/24/2018
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PRODUCTS &

Language for Historical CDR’s with Cell Site
and Additional Reports (Carrier Specific) 

AT&T:

Provide Call Detail Records (CDRs) for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:

1. All subscriber information, including name, address, contact numbers, activation/deactivation dates, account number, social security 

number, and account features

2. Cell site locations and sectors for all outgoing and incoming voice, SMS, MMS, and Data transactions.

3. All available historical precision location (NELOS) reports

4. All available Internet and Web Browsing History, to include history with and without location information.

5. All twinned/paired devices associated with the account

T-MOBILE:
Provide Call Detail Records (CDRs)/Mediations Report for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:

1. All subscriber information, including name, address, contact numbers, activation/deactivation dates, account number, social security 

number, and account features

2. Cell site locations and sectors for all outgoing and incoming voice, SMS, MMS, and Data transactions.

3. All available Timing Advance Reports, currently known as True Call, to include cell site, sector, and distance from tower, IP session and 

Data. Note: Obtaining True Call requires a phone call to T-Mobile specifically requesting it after legal demand is served. This is a new 

report that only a few compliance personnel can access. Currently, only CAST can request this record.

4. All available Mobile Data Session and IPv6 reports.

5. All available voicemails (requires order to be a Search Warrant)

Last Update 08/24/2018
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PRODUCTS &

Language for Historical CDR’s with Cell Site
and Additional Reports (Carrier Specific) 

US CELLULAR:
Provide Call Detail Records (CDRs) for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:

1. All subscriber information, including name, address, contact numbers, activation/deactivation dates, account number, social security 

number, and account features

2. Cell site locations and sectors for all outgoing and incoming voice, SMS, MMS, and Data transactions.

3. All available PCMD reports, to include LTE, IP session, and Data.

4. All text message content to include pictures OR provide the Cloud account which stores this content (Requires a Search Warrant).

5. All available Payment History and Account Memos.

6. All available True Call records.

NTELOS (soon to be Sprint):

Provide Call Detail Records (CDRs) for XXX-XXX-XXXX, for the time period XXXX – XXXXX, to include:
1. All subscriber information, including name, address, contact numbers, activation/deactivation dates, account number, social security number, and account features

2. Cell Site locations and Sectors for ALL outgoing and incoming Voice, SMS, MMS and Data transactions.

3. ALL available True Call Reports, to include cell site, sector, and distance from tower, IP session and Data.

Suggested Verbiage for obtaining 60 days of records:
“Your affiant has received advice from Federal Bureau of Investigation Special Agent David Church during this investigation. Special Agent 
Church routinely works with phone record analysis as part of his employment. Special Agent Church informed your affiant that it is often 
beneficial to review at least 60 days of records as they relate to call detail records. Your affiant believes that this range of records will 
establish a pattern of life and behavior. A smaller collection of records would make it difficult to determine if it is unusual for the phone(s) 
to appear in the areas where these crime(s) occurred. Not only will this assist in determining if the phone(s) frequents the areas of the 
crime scene(s), but also whether the phone normally belongs in these areas because that is where the phone subscriber lives and/or 
works.”

Tower Dumps
“Provide all incoming and outgoing communications (Voice, Text, and Data) from all towers and sectors that provide service to the following 
location(s):

123 Bad Guy Street, Anywhere, VA, ZIP”

Last Update 08/24/2018



Introduction to Basic Cellular Theory
Cell Towers

Examples of cell towers disguised to blend into the landscape
15
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Base Stations (Cell Towers) 

Technology Type
3G and Prior Technologies

Switch and Tower Identifiers
4G LTE Network

Switch and Tower Identifiers

AT&T

GSM (2.5G) not in all 
markets
UMTS (3G)
LTE (4G)

Location Area Code (LAC) + Cell Site ID (CID) Cell location (eCGI + eNodeB)

T-Mobile

GSM (2.5G)
UMTS (3G)
LTE (4G)

LAC + CID LTE Site ID + LTE Sector ID

Sprint
CDMA (2G/3G)
LTE (4G)

NEID + Cell
Specific VOLTE records are not currently provided. 

May see VOLTE mixed in some 3G records.

Verizon
CDMA (2G/3G)
LTE (4G)

Network Element Name + Serving Cell Site + Serving Cell Face eNB ID + Cell Face

U.S. 
Cellular

CDMA (2G/3G)
LTE (4G)

Switch + CLLI
ENODEB

(includes the country code – ENB – Sector)

UNCLASSIFIED//LES

• Networks provide service through cell towers known as base stations (BS).
• Each BS has a Global Cell ID (GCI/eCGI).  The GCI/eCGI is unique on the network and not duplicated (like 

a fingerprint).
• The Country Code is always 310 for USA, the Network Code is specific to the provider.  
• The LAC/Switch and Cell Site ID (CID) are obtained from the tower lists. For all carriers, with the 

exception of Verizon, the CID is comprised of the tower and sector.



683

693

685

695681

A cellular phone is regularly surveying the Radio Frequency (RF) environment of the cellular 
provider to identify the cell tower and sector with the BEST RF Signal.

Neighbor List

SC 691 - 71

N   695 - 84

N   693 - 91

N   685 - 93

N   683 - 94

N   681 - 97

UNCLASSIFIED//LES
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Tower and Cell Phone Communication

When a cell phone connects to a tower to conduct an outgoing call or receive 

an incoming call, the phone company (provider) maintains a record of that 

EVENT in the Call Detail Records.



Historical Cell Site Analysis
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1. Determine the phone company and portability issues of the target phone.

2. What services does the company offer?

3. Are Location Based Services (LBS), Triangulation, GPS/Ping, PCMD, True Call, or Timing Advance 
available?

4. Obtain necessary legal process.

5. Use mapping program to map relevant locations and cell towers.  Review the records in Excel or 
other tools to verify you received what you requested (date, phone, and that you received cell 
phone records with tower information).

6. Look for last call at night, first call in the morning, as well as the most frequently used cell sites 
and most frequently called phone numbers.

7. Determine the cell sector pertinent to your investigation.

8. Look for other involved subscribers (called or calling) that are in the same geographical location for 
possible leads.

10.  Review additional case information for leads in the area.

(Once case or exigent circumstance is established)

Cellular Analysis Tips
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1. Set up tower list by combining 4 columns (If using CASTViz, load original, 

non-altered record)
• LAC/Switch/Repoll/Network Element Name
• CID/Cell Number
• Sector
• Azimuth/Orientation

2. Import tower list into a mapping program

3. Plot addresses from crime

4. Filter Call Detail Record (CDR) by date and identify the tower(s) utilized 
during the date and time of the crime.

5. On your map, locate the tower/sector used during date and time of the 
crime and draw the sector coverage area based on the 
azimuth/orientation.

5 Steps For Success
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• What do we need?
• Date/Time of the Crime
• Location of the Crime Scene
• Call Detail Records (subject’s phone records)
• Tower List for the Cellular Service Provider

• How do we illustrate that on a map? 

Tower ListCall Detail Records

CASTViz

Basic Historical Cell Site Analysis
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CASTViz Overview

• CASTViz was created by the CAST team in conjunction with other government 
agencies that perform mapping analysis.  

• CASTViz is available free to law enforcement personnel, and is located at: 
https://ndcac.fbi.gov/le-portal

• The program can be downloaded to any official computer.

• Maps and analysis created by CASTViz should not be taken to court without being 
validated for accuracy.  Testimony should only be through a qualified expert.

• CASTViz has the ability to quickly plot call detail records and tower data for lead 
generation and investigative purposes.

• Once you download CASTViz, open the program and click on the “help” at the 
bottom right to access the CASTViz guide.  Please review this guide before 
contacting CASTViz@fbi.gov with questions.

https://ndcac.fbi.gov/le-portal
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CASTViz



Call Detail Records (CDR)

Historical CDR -
A data record of a particular mobile device’s activity over time
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On October 8, 2017, at approximately 5:00 a.m., the victim was 
stabbed multiple times by the suspect.   The crime occurred at 3597 
Cable Pl, Pittsburgh, PA.

MAPPING

Sample Historical Cell Site Analysis
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Crime Scene
3597 Anywhere St.

Pittsburgh, PA

Sample Historical Cell Site Analysis

On October 8, 2018, at approximately 5:00 a.m., 
the victim was stabbed multiple times by the suspect.   The 
crime occurred at 3597 Anywhere St., Pittsburgh, PA.
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Crime Scene

3597 Anywhere St.

Pittsburgh, PA

Drive testing or conducting a tower survey is the process of taking measurements
from various cell towers and illustrating the radio frequency footprint.

Green line indicates where the test equipment was in 
relation to the cell towers (black dot).

Dark shaded area indicates where the tower provides the 
best coverage compared to the surrounding towers.

Lighter shaded area illustrates what is commonly referred to 
as the overlap.  The phone could have been in this area and 

the tower could have processed the call.

Drive testing provides the 
most accurate illustration of 

a cell tower’s footprint

The method is utilized by all 
major cell providers to 
optimize their network

The survey equipment may 
consist of engineering 
phones or a scanner

Why Do Drive Testing?

Crime Scene

3597 Anywhere St.

Pittsburgh, PA
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Plotting Cell Towers (Cell Sites)
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Cell Tower Sectors

SECTOR 3
GAMMA

SECTOR 4
GAMMA

SECTOR 1
ALPHA

SECTOR 2
ALPHA

SECTOR 2
BETA

SECTOR 3
BETA

3-sector towers transmit 
signals through 3 separate 

sectors each covering 
approximately 120 degrees

120⁰
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1st determine your sector and azimuth.
It is sometimes simpler to think of degrees as hours on a clock.  

Tower Sector Orientations
Example Only (orientation can vary by tower)
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12

1

2

3

4

5

6

7

8

9

10

11
30°

60°

90°

120°

150°

180°

210°

240°

270°

300°

330°

360° 0 °

23021
AZIMUTH 240 degrees

This can be translated on to a map by using the same concept.  Determine the cell 
site and corresponding sector.  In the example below the sector is 240°. The area 
60° in either direction (or two hours) is the coverage area.

Plotting Cell Towers
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Determine the proper azimuth/orientation, and draw the sector depicting the azimuth in the 
center.  A traditional 3-sided tower will have a sector width of 120°.  The sector’s estimated 
range is based primarily on the distance to the nearest neighboring tower in the direction of the 
azimuth.  Urban areas with a higher density of towers have smaller coverage areas.  As a 
general rule of thumb, a tower’s range can be depicted as 70% of the distance to the next 
neighboring tower. The actual (RF) coverage can be mapped using cellular survey gear and 
completing a drive test.

Plotting Cell Towers

Example of a 120º azimuth

Example of a 0º azimuth
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Cell Site (Tower) Database
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…

Technical Research Group: 855-306-3222 or Askndcac@fbi.gov

General Info:  540-361-4600 or NDCAC@fbi.gov

• One-of-a-kind assistance center designed to focus on law 
enforcement’s challenges with communication services, training, and 
coordination needs

• Maintains the Cell Site Database

• Portal contains the most current version of CASTViz

• Staffed to assist local agencies with pen registers, wire intercepts, 
data intercepts, and training

• NDCAC is not an operational entity, it was established to assist with 
emerging technologies

National Domestic Communications 
Assistance Center (NDCAC)N D CAC	

https://portal-ndcac.fbi.gov
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mailto:Askndcac@fbi.gov
mailto:NDCAC@ic.fbi.gov


Cell Site Database

Email: askndcac@fbi.gov  

N D CAC	

https://portal-ndcac.fbi.gov

Database of current and archived tower lists for all major (and many local) cell phone companies.

• Ability to download tower lists by month and year

• Can search for towers by specific area, timeframe, and provider

• NDCAC will add local carriers to the database as requested 
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Cell Site Database N D CAC	

1. Click on the provider’s icon at the bottom of the screen

2. Choose the data set closest to the timeframe in the CDRs 

3. Click Download

1

2

3
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• Gives LEOs information about recent telephone number porting activity

• Useful to determine carrier of record when investigating

• To sign up for access go to: https://www.numberportability.com/

https://elep.numberportability.com/login

ELEP

UNCLASSIFIED//LES

https://www.numberportability.com/
https://elep.numberportability.com/login


Enter phone number(s) separated 
by commas or empty space 

ELEP

• The number(s) will come back with assigned company and contact info

• The list can be downloaded to Excel
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Other Useful Resources

How to Determine Phone Service Provider / Subscriber Info

Services may require paid subscription

Fone Finder www.fonefinder.net

Reverse Phone Directory www.reversephonedirectory.com

Locate Plus www.locateplus.com

CLEAR https://clear.thomsonreuters.com/clear_home/index.jsp

Google www.google.com

Accurint www.accurint.com

UNCLASSIFIED//LES

http://www.fonefinder.net/
http://www.reversephonedirectory.com/
http://www.locateplus.com/
https://clear.thomsonreuters.com/clear_home/index.jsp
http://www.google.com/
http://www.accurint.com/
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Mapping in Google Earth Pro
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Google Earth Pro

Search for Locations

• Under the SEARCH TAB you can search for 

specific address or location in Google. 
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Google Earth Pro

Add Placemarks

• The NEW PLACEMARK tool can be used to insert an ICON at any location on 

the map.  The dialogue box allow you to change the ICON properties
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Google Earth Pro

Determine Distance

• The RULER tool can be used to create a line or a circle 

with a specific radius from a known location. 
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Google Earth Pro

Uploading Towers

• Under the FILE tab select IMPORT.

• Navigate to the Student folder and select VERIZON TOWER LIST Google Earth
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Google Earth Pro

Uploading Towers

• The Data Import Wizard will help define the delimiters in the Tower List in order 

to assign columns and rows for import.   Select: Delimited>Comma>Next
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Google Earth Pro

Uploading Towers

• Uncheck this box if checked

• Use the drop downs to select the 

columns that contains the 

LATITUDE and LONGITUDE.

• Select Finish
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Google Earth Pro

Uploading Towers

• The Data Import dialogue box will appear.  Select IMPORT ALL.

• The Google Earth dialogue box will appear next. Select YES.
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Google Earth Pro

Uploading Towers

• Create new template. Select OK.

• Use the drop down to select the first Column “NAME.”   This is a column added by 

the instructors using the Excel Skill Concatenate.   This skil combines the Switch, Cell 

Number, Sector, and Azimuth so that there is unique NAME for the Towers loaded 

into Google Earth.

• Select OK.
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Google Earth Pro

Uploading Towers

• This is what the map will look like once the Tower List is uploaded.
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Google Earth Pro

Saving Data / Creating Folders

5. First create a folder specific to your case within “My Places”.  Just 

right click on “My Places”.  Click on Add Folder.  Create a name for 

your folder. 

6. Then drag and drop all pertinent locations into the folder.  (For 

example, you could drop 935 Penn. into the Training folder)

Uploading CDRs

1. Review the CDRs against the Tower List to determine the lat/long of each call 

(tower) location you want to plot.  

2. Then in Google Earth, type the lat/long from the tower list into the search bar.

3. Click on the lat/long that appears, and drag to the folder icon. This will save the 

location to your Places.  

4. Right click on the place and rename it. 

1

2

3

4

5

6
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Google Earth Pro

Viewing My Places on the map 

4. Click in the checkbox to view or hide locations on a map.
4

Email .kmz Files 

1. Drag everything you want, including any temporary places 

you want saved into the folder you created in “My Places”

2. Right click on the folder and save as a KMZ file to your drive

3. KMZ files can be attached to emails in order to share Google 

Earth results.

5

Change GPS from Decimals to 

other Formats

5. Click on Tools > Options > Then choose 

the format you want > Then click Apply.
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Google Earth Pro

Range Rings for Google Earth 
(RINGS) 
• To include rings or arcs, this add-on to Google Earth is 

helpful: http://www.metzgerwillard.us/rings/rings.html

• RINGS is an online tool that draws concentric circles, 

an annulus, or a sector of an annulus in Google Earth. 

1. Start by adding a place mark at the desired location, 

and then double click on the place mark to get it to 

move to the center of the view. 

2. Check the box beside “Setup”. 

1

3. Fill out the box that appears, and choose Rings, Annulus or Sector.

• Ring radii: minimum radius interval is 10 for feet or meters and 

0.25 for miles or kilometers. A maximum of 200 rings may be 

drawn per query.

• Annulus or sector of an annulus: to draw a disk or sector of a 

disk, enter 0 for the Starting Radius.

4. Click Draw.

5. To use the tool again, add another place mark and re-center it, or 

just re-center your original place mark.

6. Check the box beside Setup again and Click Refresh from the Edit 

menu.

2

4

Note: To save range rings from one 

Google Earth session to another, 

right-click on Saved Regions and 

select Save to My Places.

3

http://www.metzgerwillard.us/rings/rings.html
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Google Earth Pro

1

2

3

How to Look at Elevation

1. Click on the add path icon.

2. Click on your desired location and then click on the desired end location.  

Click OK. A line will appear between the two points.

3. Right click on the line, click show elevation profile.

4. If you drag the cursor over the elevation diagram from left to right, the 

elevation location will be highlighted on the map.

4
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Google Earth Pro

1

2

Clamp CASTViz Hot Tower Images to Ground 

1. Make sure the checkbox next to Hot Tower is 

checked.

2. Right click on a tower you want to clamp to 

ground.  

3. Click on the Altitude tab, and change the drop 

down to “Clamped to Ground”.

3

4. The towers will flatten, but to view the details, 

just click on the tower.

4
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Engineering Data Sets Location Based Services

AT&T

NELOS: Generates location event data via probes on the 
mobile network. Use cautiously. AT&T does not validate 
results. AT&T Messaging results: Can get content and photos if 
subscriber has this feature turned on.

Mobile Locate: Triangulated coordinates of device based 
on Timing Advance or Time on Arrival (TOA) and 
suspected radius e-mailed every 15-30 min.  Use event 
based mobile locate.

T-Mobile True Call: T-Mobile’s PCMD.  Timing Advance Data.
E-911: 3 to 6 tower triangulation based on Timing 
Advance or Time on Arrival (TOA).

Sprint

Per Call Measurement Data (PCMD):  Provides an estimate of 
the location of the device using a Round Trip Delay 
measurement from the tower. The Lat/Long provided is NOT a 
GPS coordinate. Time stamps are based on switch time and 
are held for 2 weeks to 90 days.  Evolution Data Optimized 
(EVDO):  Same as PCMD, but for data instead of voice calls.  
Long Term Evolution (LTE):  Same as PCMD, but for LTE 
usage. 

Ping: The network sends a message to the phones 
internal GPS receiver to report it's location (must see 
min. of 4 satellites.  GPS coordinates of device and 
suspected radius from tower e-mailed(or through L-Site 
website) every 15 minutes for 30 days.  Can be done 
manually every 5 minutes.

Verizon

Real Time Tool (RTT): Verizon’s PCMD provides sector/tower 
and distance from tower with confidence rating only on the 
last call/sms/data activity. The Lat/Long provided is NOT a 
GPS coordinate.  RTT is available for 7-10 days.  Actual 
Content of Text Messages is held for 3-10 days.  

Verizon has a new location tool.  Radius’ are currently 
very large, so RTT should be used also, and is based on 
the last call/sms/data activity and provides sector/tower 
and distance from tower with confidence rating.  Must 
call to request.

U.S. Cellular
PCMD: Provides an estimate of the location of the device using 
a Round Trip Delay measurement from the tower. *Only 
available in Lucent markets.

No. However, you can force a call without a ring to the 
target device to determine tower/sector.
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The Providers section of this manual has more details on each of these services



Lat:     39.75124
Long: -75.47321

Uncertainty 443 m.

• T-Mobile and AT&T offer law enforcement triangulation service as part 
of their enhanced 911 capabilities.  Both services are considered 
network solutions and perform the same function:   

• T-Mobile offers E-911 Locator 
• AT&T offers Mobile Locator tool

• Triangulation is the network’s ability to utilize the Timing Advance or 
Time of Arrival (TOA) positioning mechanism. TOA positioning method 
is based on measuring the Time of Arrival (TOA) or (Timing Advance) of 
a known signal sent from the cell phone and received at three or more 
measurement units (towers). 

E-911 / Mobile Locator Tool
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Common Device Analysis
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• Specific Crime: Determine phones used in the area

– Preserve data in case a future suspect develops

– Narrow suspect pool based on knowledge (outgoing call only, 3 minute conversation, not in 
area after crime, etc.)

– Example: Lane Bryant store where a suspect shot 6 women, no suspect

• Multiple Crimes: Different locations and times

– Compare data received for a common number

– Example: Detroit jewelry store heists – knew suspects were using cell phones due to 
surveillance cameras

Tower Dump Uses

Tower Dumps are helpful when specific cell phone numbers have not been identified, 
however they can be expensive. Cell phone providers only preserve CDRs for a 
limited time, yet tower dumps are retained longer.  Tower dumps can provide a 
wealth of information regarding which phones were in a specific place and time.  
Legal Threshold: Need a court order or search warrant.
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Events must be separated by enough distance to make tower dumps effective.  
Tower dumps can be uploaded and analyzed in CASTViz.

Tower Dump Example: Series of Robberies
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Tower Dump: CASTViz

1

1. Upload the raw tower dump files from the providers.
2. Create a location name, and upload all tower files for 

that location.  Then create the next location name (ie
Location 2) and upload those location files.

2

3 3. Once you upload the tower 
dumps for all locations, click on 
the tower dump tab at the top 
to see if there are any common 
numbers.
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Provider Voice SMS Data
PCMD/

RTT
Availability/Cost

Y N N

N
(only 

phone-
specific)

Data is available for 18 months.  
$50 per tower.

Y
Y

(CDRs)
Y Y

RTT data is available for 8 days and is $5 per 15 
min per tower. Without RTT, data is available for 

1 year and is $5 per hour per tower.

Y Y Y N/A
Data is available for 60 days.  $45 processing 

fee, and $25 per tower.

Y Possible N N/A Data is available for 6 months.  $50 per tower.

Y N N N/A Data is available for 1 year.  $50 per tower.

Tower Dumps
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• IP Addresses

• MAC Addresses

• Serial Numbers

• Advertising ID’s

• License Plate Reader (LPR’s)

• Google ID’s

• Telephone Numbers

• IMSI’s

Common Device Analysis

Through investigation, many different types of identifiers may be obtained apart from 
the information received in a tower dump. The following are examples of identifiers 
that you can use CASTViz to conduct a common analysis:

***Remember: CASTViz can be used to conduct analysis on any set of data to 
determine commonality.

• ESN’s

• MEID’s

• IMEI’s

• Social Security Numbers

• Data from Geo-fence 
Warrants
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Other Investigative Options
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There are two types of Exigent Requests. Voluntary Disclosures and compelling a provider to provide 
records due to Exigent Circumstances. The following explains both of these methods of obtaining exigency 
based records.

Voluntary Disclosure of Records (commonly referred to as “exigent requests”):

• Pursuant to 18 U.S.C. § 2702(c)(4) provides, in part: “A provider described in subsection (a) may 
divulge a record or other information pertaining to a subscriber to or customer of such service (not 
including the contents of communications)……to a governmental entity, if the provider, in good faith, 
believes that an emergency involving danger of death or serious physical injury to any person requires 
disclosure without delay of information relating to the emergency.”

• Providers have the discretion to refuse or except these requests based on the information they are 
provided by law enforcement.

• FBI personnel must obtain ASAC approval for the exigent request for records.

Compelling an Exigent Response:

• The Pen Register statute’s emergency provision, 18 U.S.C. § 3125, allows for compelling records from a 
provider. It requires approval at the Deputy Assistant Attorney General (DAAG) level or above, which is 
coordinated through the DOJ Office of Enforcement Operations (OEO). It also requires a follow-up 
court order.

• Section 3125 is occasionally used, but not often, as investigators can often obtain a pen register order 
more easily than complying with 3125’s requirements.

Exigent Requests
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Facebook / Instagram

• Send all record requests through the Facebook law enforcement portal: 
www.facebook.com/records

• Request logon, logoff, and interconnect and intra-connect activity

• Subpoena for non-content related data (basic subscriber info)
• Court order for limited content (ie. messages over 180 days)
• Search warrant for remaining content (photos, private messages, friend lists, etc.) and/or preservation of 

records
• Provide: Facebook user ID, group ID, associated user name, group name, or an e-mail address(s)
• Facebook ID is in the subject’s profile page URL. (ie. http://www.facebook.com/profile.php?id=29445421)

• Note: currently Facebook ID’s are being masked by Facebook

• Facebook will return data via e-mail in PDF or text formats.

Address: Facebook, Inc.
Attn: Security Department/Custodian of Records
1601 S. California Avenue
Palo Alto, CA 94304
subpoena@facebook.com

Facebook now provides records in two different formats. In addition to PDF, you now have the option to 

download a .zip archive of your records. The archive format allows you to view records organized by file type, 

which may allow for easier searching and parsing. Archive format records can be authenticated using a hash, 

a unique alphanumeric identifier.

The archive format is recommended when your legal process contains a request for video or other large 

media files. Please note that XML is not available at this time. The PDF format option is still available for all 

records.

http://www.facebook.com/records
http://www.facebook.com/profile.php?id=29445421
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Google

• Submit requests via the LERS: edrlawenforcement@google.com
• Request logon, logoff, and interconnect and intra-connect activity

• https://support.google.com/legal-investigations/contact/ler

• Google Voice: Request toll records, IP address information, email, google voice 
target ID, Android ID, Apple ID and all forwarding phone numbers (this is the true 
phone using the google voice app)

• This requires a 2703d order or search warrant

Phone: (650) 253-3425 for Emergency Disclosure

Google WILL notify user of all requests UNLESS the order is sealed or is a child 
exploitation order. 

mailto:edrlawenforcement@google.com
https://support.google.com/legal-investigations/contact/ler
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Apple

• Submit exigent requests from your official law enforcement email address, include a completed form, and 
email exigent@apple.com.  Include “Emergency Disclosure Request” in the subject line.

• Apple’s Emergency Law Enforcement Information Request Form can be found at 
https://www.apple.com/legal/privacy/le-emergencyrequest.pdf.

• Law enforcement guide: www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
• Apple requests that search warrants be submitted in PDF format to subpoenas@apple.com, Attention: 

Privacy and Law Enforcement Compliance
• Standard law Enforcement e-mail is lawenforcement@apple.com

Phone:
Global Security Contact Number: 408-974-2095
(available 24/7  for exigent requests)

• Extracting Data from Passcode Locked iOS Devices
• Other Available Device Information
• Requests for Apple Retail Store Surveillance Videos
• Game Center
• iOS Device Activation
• Sign-on Logs
• My Apple ID and iForgot Logs
• FaceTime 

• Information available from Apple includes, but is not limited to, the following:

• Device Registration
• Customer Service Records
• iTunes
• Apple Retail Store Transactions
• Apple Online Store Purchases
• iTunes Gift Cards
• iCloud
• Find My iPhone

* Additional Info:  Keep in mind that text messages between iPhones are data sessions and that information will not be on CDRs 

mailto:exigent@apple.com
http://www.apple.com/legal/privacy/le-emergencyrequest.pdf
http://www.apple.com/legal/privacy/law-enforcement-guidelines-us.pdf
mailto:subpoenas@apple.com


UNCLASSIFIED//LES

OnStar

• OnStar customer service records (audio and/or general account information)requires receipt 
of a subpoena, court order, or other proper court issued document

• In the subpoena, identify date & time of the occurrence(s), description of the service, and/or 
account records being sought

• To locate an OnStar account provide at least one of the following: 

1. Vehicle Identification Number, to include year, make, model
2. Subscribers full name and mailing address to include zip code
3. Home phone number on file
4. OnStar Account Number
5. OnStar Hands Free Calling (HFC) Number
6. Request to Identify an OnStar Good Samaritan will require the date of the call, and the OnStar

case number provided to 9-1-1 dispatch by OnStar at the time of the call

Contact Info:

• Call 888-690-2882 for each state’s Corporation Service Company local address
• Address the subpoena to: OnStar LLC, and mail it to the address provided by Corporation 

Service Company
• No fee for submitting subpoenas

• www.onstar.com

http://www.onstar.com/
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OnStar

Vehicle Location(s) OnStar only maintains location data that is specific to a car when: 

There is a request for service initiated from within the car;

There is a request for Stolen Vehicle Assistance or to locate a missing person;

There is an Air Bag Deployment;

There is an Automatic Crash Response;

All other location data collected and maintained by OnStar is anonymized and cannot be tied back to a specific car or event.

Vehicle Activity OnStar does not create, receive or maintain vehicle activity such as speed, braking, ignition cycles, lock 

status, etc. You can contact the vehicle manufacturer regarding any data their system(s) may have. If the car is equipped with 

AACN we may have airbag data, maximum reported Delta V, direction of impact and roll over status.

Vehicle Speed OnStar does not maintain speed data that is specific to a car, account or customer. 

Audio files are ONLY created for voice calls that go into or through the OnStar Call Centers from a landline call, a blue button 

or emergency button key press, or from an airbag/automatic crash response signal from the vehicle. We do NOT have audio 

files from inside the vehicle when there is an established data connection with the vehicle. (i.e. when actively assisting law 

enforcement with locating a stolen vehicle, when updating the vehicle’s location to provide service, when placing a call to 

emergency services providers.)

Call detail/toll records; OnStar is a reseller of cellular minutes which are purchased by the subscribers on a pre-paid basis; 

therefore OnStar does not have Call Detail records. Minimal call data is received from our carrier 90 days after the date the 

Hands Free Calling (HFC) service was used, that detail being the date of the call, duration of the call, number dialed and 

number calling 90 days after the call was made. 

OnStar does not create or provide transcripts of audio recordings. OnStar cannot guarantee that an audio recording was taken at the time of a call or that a call can be retrieved 

and restored from our archives. OnStar maintains audio for 90 days from the date of the call.

[2] If you are unable to submit a subpoena at this time, OnStar will preserve the audio and/or records, if made and available, upon written request. 

[3] For all civil matters, per our privacy statement, we require either documentation of our subscribers consent and/or documentation of Notice of Discovery to obtain their 

records. NOTE: OnStar is not governed by HIPPA or FOIA.

http://ems00619.egain.net/system/web/view/knowledge/kb/contentbody.jsp
http://ems00619.egain.net/system/web/view/knowledge/kb/contentbody.jsp


UNCLASSIFIED//LESUNCLASSIFIED//LES

http://images.google.com/imgres?imgurl=http://www.americanwireless.com/images/coop/att/att_gophone.gif&imgrefurl=http://boardingarea.com/blogs/pointswizard/category/disposable-cell-phone/&usg=__8be92YktVdwE67VBpewtxGMNsaE=&h=2000&w=2000&sz=81&hl=en&start=12&um=1&tbnid=bjJjXmkD8kOXLM:&tbnh=150&tbnw=150&prev=/images?q=Go+Phone&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.americanwireless.com/images/coop/att/att_gophone.gif&imgrefurl=http://boardingarea.com/blogs/pointswizard/category/disposable-cell-phone/&usg=__8be92YktVdwE67VBpewtxGMNsaE=&h=2000&w=2000&sz=81&hl=en&start=12&um=1&tbnid=bjJjXmkD8kOXLM:&tbnh=150&tbnw=150&prev=/images?q=Go+Phone&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://nahright.com/news/wp-content/images/Boost_mobile.jpg&imgrefurl=http://nahright.com/news/2007/11/21/boost-mobile-anthem-20/&usg=__SpJgdADTIUElHgYfE9wAF911D68=&h=407&w=399&sz=20&hl=en&start=1&um=1&tbnid=muhkUE3khxA1TM:&tbnh=125&tbnw=123&prev=/images?q=boost+mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://nahright.com/news/wp-content/images/Boost_mobile.jpg&imgrefurl=http://nahright.com/news/2007/11/21/boost-mobile-anthem-20/&usg=__SpJgdADTIUElHgYfE9wAF911D68=&h=407&w=399&sz=20&hl=en&start=1&um=1&tbnid=muhkUE3khxA1TM:&tbnh=125&tbnw=123&prev=/images?q=boost+mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://images.dealsvista.com/show?&id=18820&imgrefurl=http://www.dealsvista.com/deal/tracfone-moto-w260-bundled-w-double-minutes-for-the/24004&usg=__Fh97Y6fPr2lUAoAn7tiuoql3Vu8=&h=250&w=250&sz=101&hl=en&start=137&um=1&tbnid=9Mr_qhJmEN8I2M:&tbnh=111&tbnw=111&prev=/images?q=Tracfone&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=120&um=1
http://images.google.com/imgres?imgurl=http://images.dealsvista.com/show?&id=18820&imgrefurl=http://www.dealsvista.com/deal/tracfone-moto-w260-bundled-w-double-minutes-for-the/24004&usg=__Fh97Y6fPr2lUAoAn7tiuoql3Vu8=&h=250&w=250&sz=101&hl=en&start=137&um=1&tbnid=9Mr_qhJmEN8I2M:&tbnh=111&tbnw=111&prev=/images?q=Tracfone&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=120&um=1
http://images.google.com/imgres?imgurl=http://www.prepaid-wireless-guide.com/images/tracfone_logo.gif&imgrefurl=http://www.prepaid-wireless-guide.com/wireless-providers.html&usg=__GLRO3tUGEnyHP57RJGue0CkLcHU=&h=100&w=200&sz=4&hl=en&start=40&um=1&tbnid=jOcvAiTXs-E10M:&tbnh=52&tbnw=104&prev=/images?q=Tracfone&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://www.prepaid-wireless-guide.com/images/tracfone_logo.gif&imgrefurl=http://www.prepaid-wireless-guide.com/wireless-providers.html&usg=__GLRO3tUGEnyHP57RJGue0CkLcHU=&h=100&w=200&sz=4&hl=en&start=40&um=1&tbnid=jOcvAiTXs-E10M:&tbnh=52&tbnw=104&prev=/images?q=Tracfone&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://www.getkidzfit.org/logos/MetroPCS.jpg&imgrefurl=http://www.getkidzfit.org/2009sponsors.html&usg=__neq61lvLOLOMMT0Wn0eB6qyIFmA=&h=600&w=2100&sz=72&hl=en&start=24&um=1&tbnid=tkZadtR3H6Ym4M:&tbnh=43&tbnw=150&prev=/images?q=metro+pcs&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://www.getkidzfit.org/logos/MetroPCS.jpg&imgrefurl=http://www.getkidzfit.org/2009sponsors.html&usg=__neq61lvLOLOMMT0Wn0eB6qyIFmA=&h=600&w=2100&sz=72&hl=en&start=24&um=1&tbnid=tkZadtR3H6Ym4M:&tbnh=43&tbnw=150&prev=/images?q=metro+pcs&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://www.citizenofthemonth.com/wp-content/uploads/2007/02/att3.jpg&imgrefurl=http://www.citizenofthemonth.com/2007/02/04/short-tales-of-the-weekend/&usg=__umjSsUZejCjGaVIZUDc9oa0q7qw=&h=360&w=340&sz=19&hl=en&start=17&um=1&tbnid=UzMWsQqWoYfvkM:&tbnh=121&tbnw=114&prev=/images?q=LEAP+cell+service&hl=en&rlz=1T4SKPB_enUS347US348&um=1
http://images.google.com/imgres?imgurl=http://www.citizenofthemonth.com/wp-content/uploads/2007/02/att3.jpg&imgrefurl=http://www.citizenofthemonth.com/2007/02/04/short-tales-of-the-weekend/&usg=__umjSsUZejCjGaVIZUDc9oa0q7qw=&h=360&w=340&sz=19&hl=en&start=17&um=1&tbnid=UzMWsQqWoYfvkM:&tbnh=121&tbnw=114&prev=/images?q=LEAP+cell+service&hl=en&rlz=1T4SKPB_enUS347US348&um=1
http://images.google.com/imgres?imgurl=http://gadgetcoolstuff.files.wordpress.com/2008/08/t-mobile-phone-operator1.jpg&imgrefurl=http://gadgetcoolstuff.wordpress.com/&usg=__9mkWx2vqYZXMUJqHfhagiDA2phA=&h=1276&w=5547&sz=183&hl=en&start=2&um=1&tbnid=-cx8an4r2esjZM:&tbnh=35&tbnw=150&prev=/images?q=T-Mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://gadgetcoolstuff.files.wordpress.com/2008/08/t-mobile-phone-operator1.jpg&imgrefurl=http://gadgetcoolstuff.wordpress.com/&usg=__9mkWx2vqYZXMUJqHfhagiDA2phA=&h=1276&w=5547&sz=183&hl=en&start=2&um=1&tbnid=-cx8an4r2esjZM:&tbnh=35&tbnw=150&prev=/images?q=T-Mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://i.zdnet.com/blogs/verizonwirelesslogo.png&imgrefurl=http://blogs.zdnet.com/cell-phones/?p=2551&usg=__4TstxiSBojMu7Fn12VD3AX_S6jw=&h=325&w=610&sz=23&hl=en&start=2&um=1&tbnid=BpcSl8SPZ9-2UM:&tbnh=72&tbnw=136&prev=/images?q=verizon+wireless&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://i.zdnet.com/blogs/verizonwirelesslogo.png&imgrefurl=http://blogs.zdnet.com/cell-phones/?p=2551&usg=__4TstxiSBojMu7Fn12VD3AX_S6jw=&h=325&w=610&sz=23&hl=en&start=2&um=1&tbnid=BpcSl8SPZ9-2UM:&tbnh=72&tbnw=136&prev=/images?q=verizon+wireless&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.mobiletor.com/images/cricket-communications-logo.jpg&imgrefurl=http://www.mobiletor.com/2009/07/23/cricket-txtm8-feature-packed-phone/&usg=__47Uv_SlAAOm3DCXgDoxSuEu-eRM=&h=300&w=320&sz=25&hl=en&start=2&um=1&tbnid=dQubD96LKTEYvM:&tbnh=111&tbnw=118&prev=/images?q=cricket+communications&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.mobiletor.com/images/cricket-communications-logo.jpg&imgrefurl=http://www.mobiletor.com/2009/07/23/cricket-txtm8-feature-packed-phone/&usg=__47Uv_SlAAOm3DCXgDoxSuEu-eRM=&h=300&w=320&sz=25&hl=en&start=2&um=1&tbnid=dQubD96LKTEYvM:&tbnh=111&tbnw=118&prev=/images?q=cricket+communications&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://andygreenhaw.files.wordpress.com/2009/07/sprint20logo201.jpg&imgrefurl=http://andygreenhaw.wordpress.com/2009/07/&usg=__TN1Hr0nD8QTpFcyLohtKoOAbWqk=&h=325&w=600&sz=94&hl=en&start=5&um=1&tbnid=4KxUWz0_-gpywM:&tbnh=73&tbnw=135&prev=/images?q=Sprint&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://andygreenhaw.files.wordpress.com/2009/07/sprint20logo201.jpg&imgrefurl=http://andygreenhaw.wordpress.com/2009/07/&usg=__TN1Hr0nD8QTpFcyLohtKoOAbWqk=&h=325&w=600&sz=94&hl=en&start=5&um=1&tbnid=4KxUWz0_-gpywM:&tbnh=73&tbnw=135&prev=/images?q=Sprint&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://global-prepaid.com/images/categories/virgin_mobile_logo.gif&imgrefurl=http://global-prepaid.com/index.php?cPath=1&main_page=index&usg=__OMRjpPzQ33XFXuMeE5NYsysgwr8=&h=343&w=600&sz=27&hl=en&start=4&um=1&tbnid=Rlf_ELD-F1Af6M:&tbnh=77&tbnw=135&prev=/images?q=Virgin+Mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://global-prepaid.com/images/categories/virgin_mobile_logo.gif&imgrefurl=http://global-prepaid.com/index.php?cPath=1&main_page=index&usg=__OMRjpPzQ33XFXuMeE5NYsysgwr8=&h=343&w=600&sz=27&hl=en&start=4&um=1&tbnid=Rlf_ELD-F1Af6M:&tbnh=77&tbnw=135&prev=/images?q=Virgin+Mobile&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.net10.com/news_center/downloads/NET10Logo.jpg&imgrefurl=http://www.net10.com/news_center.jsp?task=news_center&nextPage=news_center.jsp&section=pressKit&subsection=images&usg=__-j2mQg7hvLOUyAstKbp6Bd9_MSw=&h=389&w=825&sz=38&hl=en&start=6&um=1&tbnid=IewOW-pcVH-QlM:&tbnh=68&tbnw=144&prev=/images?q=Net+10&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.net10.com/news_center/downloads/NET10Logo.jpg&imgrefurl=http://www.net10.com/news_center.jsp?task=news_center&nextPage=news_center.jsp&section=pressKit&subsection=images&usg=__-j2mQg7hvLOUyAstKbp6Bd9_MSw=&h=389&w=825&sz=38&hl=en&start=6&um=1&tbnid=IewOW-pcVH-QlM:&tbnh=68&tbnw=144&prev=/images?q=Net+10&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://www.ubergizmo.com/photos/2007/11/alltel-familyfinder.jpg&imgrefurl=http://www.ubergizmo.com/15/archives/2007/11/alltel_wireless_axcess_family_finder.html&usg=__yrVUEHq0ZDSTa0cTCctnbJAAAV0=&h=259&w=468&sz=11&hl=en&start=22&um=1&tbnid=9CpbSA2TAhqh6M:&tbnh=71&tbnw=128&prev=/images?q=alltel&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://www.ubergizmo.com/photos/2007/11/alltel-familyfinder.jpg&imgrefurl=http://www.ubergizmo.com/15/archives/2007/11/alltel_wireless_axcess_family_finder.html&usg=__yrVUEHq0ZDSTa0cTCctnbJAAAV0=&h=259&w=468&sz=11&hl=en&start=22&um=1&tbnid=9CpbSA2TAhqh6M:&tbnh=71&tbnw=128&prev=/images?q=alltel&ndsp=20&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&start=20&um=1
http://images.google.com/imgres?imgurl=http://marketing.depaul.edu/images/mulitcultural/US_Cellular_Logo_Feb_09.jpg&imgrefurl=http://marketing.depaul.edu/MulticulturalMarketing/Summit_2009/Partners_and_Board_Members.asp&usg=__hIGJg4sJPpT2lpZ53RgWnI-qdUU=&h=1106&w=4384&sz=167&hl=en&start=1&um=1&tbnid=b99t5VgBu2_gVM:&tbnh=38&tbnw=150&prev=/images?q=us+cellular+logo&hl=en&rlz=1T4SKPB_enUS347US348&um=1
http://images.google.com/imgres?imgurl=http://marketing.depaul.edu/images/mulitcultural/US_Cellular_Logo_Feb_09.jpg&imgrefurl=http://marketing.depaul.edu/MulticulturalMarketing/Summit_2009/Partners_and_Board_Members.asp&usg=__hIGJg4sJPpT2lpZ53RgWnI-qdUU=&h=1106&w=4384&sz=167&hl=en&start=1&um=1&tbnid=b99t5VgBu2_gVM:&tbnh=38&tbnw=150&prev=/images?q=us+cellular+logo&hl=en&rlz=1T4SKPB_enUS347US348&um=1


UNCLASSIFIED//LES

Contact 
Info

Acquired 
Companies/Resellers

Technology 
Type

Engineering Data Sets Location Based Services Other

AT&T
(800) 635-

6840

Cricket; Alltel; 7-11 Speak Out; 
Beyond Wireless; Bratz Mobile; 
Circle K - Talk and Go Mobile; 
cool. Prepaid; Firefly Mobile; 

GoPhone; Graffiti Wireless; GTC 
Wireless; Hop-On; KORE 

Wireless; Locus Mobile; NET10; 
Teleplus; Tuyo Mobile; U 

Prepaid; XE Mobile

GSM (2.5G) 
rarely seen it 

most 
markets; 

UMTS (3G); 
LTE (4G)

NELOS: Generates location event 
data via probes on the mobile 
network. Use cautiously. AT&T does 
not validate results. AT&T 
Messaging results: Can get content 
and photos if subscriber has this 
feature turned on.

Mobile Locate: Triangulated 
coordinates of device based on 
Timing Advance or Time on 
Arrival (TOA) and suspected 
radius e-mailed every 15-30 
min.  Use event based mobile 
locate.

Use data 
cautiously during 
investigation and 
DO NOT rely on 
data for 
testimonies.

T-
Mobile

(973) 292-
8911

metroPCS
GSM (2.5G); 
UMTS (3G); 

LTE (4G)

True Call: T-Mobile’s PCMD.  Timing 
Advance Data.

E-911: 3 to 6 tower 
triangulation based on Timing 
Advance or Time on Arrival 
(TOA).

Use data 
cautiously during 
investigation and 
DO NOT rely on 
data for 
testimonies.

Sprint
(800) 877-

7330

Boost Mobile; 9278 Mobile; Bravo 
Wireless; Global Talk PCS; GSR 
Mobile; Liberty Wireless; Mobile 
ESPN; MoveU Mobile; Movida 
Communications; PhoneCo; 

PlatinumTel Communications; 
STI Mobile; Time Warner; Total 

Call; Uphonia; Virgin Mobile USA; 
ZUMA Prepaid Wireless

CDMA 
(2G/3G); LTE 

(4G)

Per Call Measurement Data 
(PCMD):  Provides an estimate of 
the location of the device using a 
Round Trip Delay measurement 
from the tower. Time stamps are 
based on switch time and are held 
for 2 weeks to 90 days.  Evolution 
Data Optimized (EVDO):  Same as 
PCMD, but for data instead of voice 
calls.  Long Term Evolution (LTE):  
Same as PCMD, but for LTE usage.

Ping: The network sends a 
message to the phones internal 
GPS receiver to report it's 
location (must see min. of 4 
satellites.  GPS coordinates of 
device and suspected radius 
from tower e-mailed(or through 
L-Site website) every 15 
minutes for 30 days.  Can be 
done manually every 5 minutes.

No tower info 
provided on SMS 
records.  Do not 
use the lat/long 
in PCMD records, 
use the tower 
distance.

Verizon
(800) 451-

5242

Alltel; Amp'd Mobile; IDT; 
MobilePro; CloseCall; Omni 

Prepaid; Page Plus; Rockit Talk

CDMA 
(2G/3G); LTE 

(4G)

Real Time Tool (RTT): Verizon’s 
PCMD provides sector/tower and 
distance from tower with confidence 
rating only on the last 
call/sms/data activity.
RTT is available for 7-10 days.  
Actual Content of Text Messages is 
held for 3-10 days.  

No.  However, Verizon is
working on creating a tool.  RTT 
can be used though, and is 
based on the last call/sms/data 
activity and provides 
sector/tower and distance from 
tower with confidence rating.  
Must call to request.

U.S. 
Cellular

(630) 875-
8270

Carolina West Wireless
CDMA 

(2G/3G); LTE 
(4G)

Per Call Measurement Data 
(PCMD):  PCMD provides an 
estimate of the location of the 
device using a Round Trip Delay 
measurement from the tower. 

No. However, you can force a 
call without a ring to the target 
device to determine 
tower/sector.
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Provider AT&T Cricket (AT&T) T-Mobile MetroPCS (T-mobile) Sprint Verizon US Cellular

Subscriber 7 years 12/20/2015-present
2 years prepaid; since account 

opened with postpaid
2 years 10 years 3-5 years 7 years

Call Detail 
Records

7 years 12/20/2015-present
2 years prepaid; since account 

opened with postpaid
2 years

18 months; backup 
tapes available 2005 

to present
1 year 1 year

Cell Site 
(Voice)

7 years 12/20/2015-present 2 years 2 years 18 months 1 year 1 year

SMS tolls 7 years 12/20/2015-present 2 years 2 years 18 months 1 year 1 year

Cell Site
(SMS)

7 years 12/20/2015-present 2 years 2 years
No CDR, Yes Reveal 
(PCMD) for 90 days

No CDR, Yes RTT 
(PCMD) 8-30 days

No

SMS content
No (AT&T msg 

app 90 days; 
~10%)

No No No Only on T-III 7 days 3-5 days

Cell Site 
(Data)

7 years 12/20/2015-present No No
90 days (if request 

IPDR Report)
1 year No

Tower Dumps 7 years 12/20/2015-present 2 years 2 years 18 months 1 year 1 year

Prospective
Mobile Locate 

(Triangulation / 
AGPS)

Mobile Locate 
(Triangulation / AGPS)

E911 (Triangulation) No
GPS "Ping" (device 

dependent)
Yes

No, but force 
"no ring" call

PCMD/RTT 
(Historic)

No, but NELOS 
(90 days)

No, but NELOS (90
days)

No No
PCMD (~90 days 

SMS & voice; 2 
weeks data)

RTT 8 days PCMD (30 days)

WiFi Calling Pending Pending App / Open WiFi No 18 months
On VoLTE report 

only
No

VoLTE Yes Yes Yes since account opened No Yes 90 days Yes 1 year Yes 1 year

Store Video Yes Yes 15-45 days (sbp) 15-45 days (sbp) 2-3 months (sbp) 30 days (sbp)
30-60 days 

(sbp)

Voicemail 
Yes- all stored 

VMs
Yes- all stored VMs 14 days 14 days 20 days No No

Cloud Storage AMS AMS Via Synchronoss

Internet/Web 
Browsing

1 year 1 year No No No 187 days No

(As of March 2019)
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Provider For Use in Google Earth or other mapping program Into CASTViz

AT&T

1. Import Txt file into Excel, and use text to columns (Delimited)
2. Insert a tab after column B.  In the new column use the formula =b2-7/24 for UTC to PDT
3. Drag the formula down the entire spreadsheet
4. Create tabs for voice, data, sms.  Do not map the data tab
5. In the voice tab, use Text to Columns to separate “Cell Location” Column into LAC, CID, Latitude, 

Longitude, and Orientation. 
6. Sort so times are in chronological order
7. Add filters and filter for the timeframe of interest. 
* Fields that match tower list: LAC, CID, and Orientation

Do not alter the Txt file.  
Import raw files.
Can Import CDR as Tower 
file also.

T-Mobile

1. Freeze top row (View > Freeze Panes > Freeze Top Row)
2. Adjust “Start Time” column to correct time zone, then sort in chronological order
3. Add filter to top row (Home > Sort & Filter > Filter)
4. Filter for needed timeframe
* Fields that match tower list: 1st LAC, 1st Cell ID, 1st Tower Azimuth.  For LTE: 1st LTE Site ID, 1st Tower 
Azimuth

Save as an Excel doc, then 
import.
Can Import CDR as tower 
file also.

Metro PCS 1. See T-mobile (above) Import the raw excel files. 

Sprint

1. Freeze top row (View > Freeze Panes > Freeze Top Row)
2. Adjust “Start_Date” column to correct time zone, then sort in chronological order
3. Add filter to top row (Home > Sort & Filter > Filter). In the “M_R_#” column uncheck Routed Call and 

Undetermined data
4. Check 1st # in “1st CELL” column to determine if sectors are Lucent (2,3,4) or Nortel (1,2,3)
5. Filter for needed timeframe
* Fields that match tower list: NEID, 1st CELL (this is the sector & the Cell#)

Import the raw excel files. 

Verizon

1. Freeze top row (View > Freeze Panes > Freeze Top Row)
2. Adjust “Seizure Dt Tm” column to correct time zone, then sort in chronological order
3. Check First Serving Cell Face to determine if sectors are Lucent (2,3,4) or Nortel (1,2,3)
4. Add filter to top row (Home > Sort & Filter > Filter).  Filter for needed timeframe
* Fields that match tower list: Network Element Name, First Serving Cell Site, and First Serving Cell Face

Import the raw excel files. 
Tower list is a .CSV file. 

U.S. Cellular

1. Freeze top row (View > Freeze Panes > Freeze Top Row)
2. Change time from local switch to correct timezone, if needed.  Sort time in chronological order
3. If outbound call, use orig CLLI. If inbound call, use term CLLI
4. If Nortel, convert the orig CLLI and term CLLI from hex to dec:  =HEX2DEC(Left(U7,3)
5. Add filter to top row (Home > Sort & Filter > Filter).  Filter “Call Type” column for M.  Filter for needed 

timeframe
* Fields that match tower list: Orig CLLI or Term CLLI.  Records show location for both the originating and 
receiving phone

CASTViz does not import 
this provider. Reinjest is 
required to parse records.
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Provider For Use in Google Earth or other mapping program Into CASTViz

AT&T Concatenate the LAC, CID, and Sector Orientation

Export from Cell Site Database, save, then import to CASTViz, 
and change the time from UTC.

OR:
upload the raw txt CDR file and change the time from UTC.  

T-Mobile
Concatenate the LAC, Cell_id, and Orientation.  (Just FYI-
the sector is the 1st digit of the sector column.)  For LTE, 

concatenate the eNodeB_ID, and Azimuth
Export from Cell Site Database, save, then import to CASTViz.

Metro PCS Concatenate the Switch, Cell, and Sector Export from Cell Site Database, save, then import to CASTViz.

Sprint Concatenate the NEID, Cell #, Sector, and Azimuth
Export from Cell Site Database, save, then import to CASTViz.

If Lucent, check the Lucent Box.

Verizon
Concatenate the Switch Name, Cell Number, Sector, and 

Azimuth.  Save as CSV
Export from Cell Site Database, save, then import to CASTViz.

If Lucent, check the Lucent Box.

U.S. Cellular
Concatenate Switch Name, Cell Number, Sector, and 

Orientation / Azimuth
CASTViz does not import this provider. Reinjest required to 

parse records.
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Get the tower list from the Cell Site Database Archives section.  
Ensure the tower list is dated close to the time of the crime.  
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Mobile Virtual Network Operator (MVNO)

• Company that purchases network capacity to offer their own wireless services using 

the network of another telecommunications provider (i.e., Verizon Wireless, AT&T, 

Sprint).  

• Examples of MVNO services:

• Prepaid phone cards that can be bought at local convenience stores

• Mobile phones (“burner phones”) that are programmed to have prepaid wireless service 

once activated  (ie. Boost mobile is a cellular reseller for Sprint)

• Subscriber and toll info is kept by MVNOs

• Telephone records & cell site data is kept by owner of network (same for roaming 

phones)

MVNO (Cellular Resellers)

CDRs for MVNO “burner” phones are available.  

The CDRs with the cell site data are available through the 

network that handled the call (ie. Verizon, Sprint).
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Contact Information:

National Compliance Center (800) 635-6840

National Compliance Fax (888) 938-4715

Subpoena Compliance (800) 291-4952

Fax (SW and East Region) (248) 552-1764

Fax (West Region) (248) 552-1793

Fax (Midwest Region) (248) 552-3201

Fax AT&T Corp (All other regions) (248) 552-3236

Address:
AT&T National Compliance Center
11760 US Highway 1, 4th floor/Ste 600
North Palm Beach, FL 33408

AT&T National 
Land Lines:

208 South Akard, 10th Floor
Dallas, TX 75202

AT&T

Technology: GSM (2.5 G), UMTS (3G), LTE (4G)

Cricket records are obtained by contacting AT&T. 
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http://images.google.com/imgres?imgurl=http://www.mobiletor.com/images/cricket-communications-logo.jpg&imgrefurl=http://www.mobiletor.com/2009/07/23/cricket-txtm8-feature-packed-phone/&usg=__47Uv_SlAAOm3DCXgDoxSuEu-eRM=&h=300&w=320&sz=25&hl=en&start=2&um=1&tbnid=dQubD96LKTEYvM:&tbnh=111&tbnw=118&prev=/images?q=cricket+communications&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
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AT&T

How They Will 
Send Records

• Will email the .PDF and .txt file(s) to secure law enforcement accounts. 
Always request the .txt file (which will include Voice, SMS, and data).

• Records are also available on CDs

CDRs (voice)

• Includes incoming/outgoing complete, incomplete, and blocked calls, 
location, international calls, and roaming calls (AT&T users roaming 
outside AT&T network or customers of other networks roaming on the 
AT&T network)

CDRs (SMS)
• Includes sending and receiving information (e.g., when the text was 

sent and when it was received, originating and terminating numbers, 
location, etc.).  Does not include content.

CDRs (data)

• Includes data (i.e. multimedia messages, email, web surfing, etc.) sent 
and received by mobile callers.  Roaming data is also included.  Only 
session times and locations are available.  

• Data sessions route differently than voice/SMS sessions through the 
network.  At this time, CAST does not rely on data sessions for 
testimonial purposes.
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AT&T

Cost Per Pen 
Register

• $325 installation fee, $5 for each day

• No switch restrictions

Phrase to use in 
historical records 
orders/warrants

• “All available toll records to include call detail, cell site and cell site 
sector information from (date) to present, as well as any available 
NELOS records.” 

• (A NELOS request will require a probable cause statement)

Calls to 
Destinations 
Search

• Subpoena requesting query of commonly called numbers by the 
target’s previous device to determine a new target phone number

• Use this if your subject drops phones frequently

• No cost, 60 day limit

Engineering Data 
Set

• NELOS: Generates location event data via probes on the mobile 
network.  Use cautiously.  No QA is performed by AT&T.

Location Based 
Services

• Mobile Locator Tool (Triangulation): GPS coordinates of phone and 
suspected radius. Results emailed every 15 mins for 30 days. 

• Time Difference of Arrival (TDOA): Relies on measuring the signal from 
a device from two or more cell sites. The mobile switch compares the 
times to generate a lat/long for the caller. 



UNCLASSIFIED//LES

Network Events:

• GPS- Observes GPS/precision location 
information supplied by the handset in the course 
of the user permitting location services on the 
device to provide a location. Accuracy Rating: 1

• FemtoCell- Observes device connected to a 
FemtoCell, which is programmed to report GPS 
coordinates periodically to AT&T. Accuracy 
Rating: 2

• Timing Advance / Round Trip Delay-
Generates location records for scenarios where 
low propagation delay indicates very near 
presence to a particular cell tower (within 200M). 
Accuracy Rating: 3-12

• Signal strength- Used to estimate location in 
two different ways but is more vulnerable to 
error in situations where the user equipment is in 
proximity of a radio repeater, a body of water or 
some other physical obstacle that could impact 
the signal strength.

AT&T NELOS
(Network Element Location Optimization Service)

NELOS Legend: Location Accuracy Key

0 Location accuracy unknown

1 Location accuracy likely better than 25 meters

2 Location accuracy likely better than 50 meters

3 Location accuracy likely better than 100 meters

4 Location accuracy likely better than 200 meters

5 Location accuracy likely better than 300 meters

6 Location accuracy likely better than 400 meters

7 Location accuracy likely better than 600 meters

8 Location accuracy likely better than 1000 meters

9 Location accuracy likely better than 1500 meters

10 Location accuracy likely better than 2500 meters

11 Location accuracy likely better than 5000 meters

12 Location accuracy likely better than 10000 meters

13 Location accuracy likely better than 25000 meters

GPS

FemtoCell

Timing 

Advance / 

Round Trip 

Delay

Tower 

Sector 

Only

CAST currently does not testify to the accuracy to NELOS 
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AT&T NELOS
* Formal statement from AT&T.  Dated Nov. 21, 2017.
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Connection Date.  Connection Time.  The ring 
time for answered calls the time prior to answer: 
For answered calls, it is difference between call 
attempt and connection times.  For unanswered 
calls, it is the time from attempt until disconnect.   
In the first case, attempt time + seizure = 
connection time.   In the second case, call 
attempt time (which is same as connect time) + 
seizure time = disconnect time.

Row 
number

Duration of 
transaction 
in HH:MM

Number placing 
the call

Number 
called International Mobile 

Equipment Identity

International Mobile 
Subscriber Identity. 
Subscriber number / 

identifier

Call 
type

Type of 
transaction

Provides the LAC/CID or 4G eCGI.  Also provides 
the sector orientation and beam width 

information. *Lat/Long are provided for the 
towers at the time the report is generated.

Current records are in UTC.  
Older records are in switch time.

AT&T CDR
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AT&T CDR & Tower List

As of 8/2015, AT&T is sending current tower data within historical CDRs.  For example, 2012 CDRs include 2015 tower 

information.  Every tower needs to be verified.  You must use the cell site database to get the towers for the correct timeframe.
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AT&T Additional Notes:

• Can get CDRs for wearables.  Get the IMSI for the wearable, then ask AT&T 

for the additional CDR based on that IMSI (the phone number will be 

different).
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Sprint

Contact Information:

Electronic Surveillance (Surveillance, PTT, T-3s, GPS, 
911, exigent)

(800) 877-7330
Fax (816) 600-3100

Subpoena Compliance (historic records, testimony)
Compliance Questions: Scg-projects@Sprint.com

(800) 877-7330
Fax (816) 600-3111

Immediate Records Request (IRR)
(913) 315-8774

Fax (816) 600-3121

Ping Request
(913) 315-8805

Fax (816) 600-3100

Sprint Corporate Security
6480 Sprint Parkway

Overland Park, KS 66251

Technology: CDMA & LTE
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Sprint

How They Will 
Send Records

• Sprint will provide Microsoft Excel file(s) and email them to a secure 
law enforcement account, if requested

• Records should be sent electronically

• All requests can be made and received on Sprint’s law enforcement 
portal (L-Site)

CDRs

• 18 months with Cell/Sector records

• ‘No charge’, but fees may be incurred if the request is burdensome

• CDR Backup tapes are available 2005-present.  Cost: $300 for each day 
of records requested

CDRs (SMS)

• Can provide content, but a TIII is required.

• Text (toll detail): 18-24 months (no tower info)

• "Time Zones: As of 06/04/2018, text message time stamps are in GMT. Please be advised 

that between 06/01/2017 and 05/31/2018, text message time stamps may be in GMT if the 

NEID is in the range 540-559 or, Central time zone for all others. From October 12, 2010 

through May of 2017 text message time stamps were kept in Central time zone. Records prior 

to October 12, 2010 are either in Central or Eastern time zone. Sprint is unable to determine 

which time zone is reflected in records older than October 12, 2010. "
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Sprint

Cost Per Pen 
Register

• Implementation: $400 per market, but the price is capped at $2,000 
(not charged again if extension is made prior to termination)

• Maintenance fee: $10 per day with no cap

Phrase to use in 
historical records
orders/warrants

• “All available call detail records to include voice, SMS detail, data 
sessions, per call measurement data (PCMD), cell site and cell site 
sector information from (date) to present”

Calls to 
Destinations 
Search

• Data held for 18 months

• Cost- Depends on how it is billed.  Cost could be $50 flat fee or $30 per 
hour of research

• Legal Threshold- Subpoena

IP Data Sessions

• To get cell and sector info, request the following:

• "....all data connection logs to include cell sites, or location 
information......“

• Sprint cannot currently translate IPV4 addresses (ex. 152.138.17.240) 
to an actual phone number

• Sprint may be able to translate IPV6 addresses (ex. 
001:0db8:0000:0042:0000:8a2e:0370:7334) to a phone number
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Engineering Data Sets/
Location Based Services

GPS PING

• If not set up through L-Site, cost is $20 per manual request 

• Alpha (Assisted) GPS: Silent Call-location, Update based on satellite, 
Read on GPS

• Hybrid GPS: Combo of 1 or 2 satellites and towers

• AFLT: Advanced Forward Link Trilateration

L-Site “PING”

• $30 flat fee per month on L-Site

• Can set up your own pings, receive info faster than manual requests 

• Lat/Long coordinate of phone and radius of uncertainty

• Pings can occur every 15 mins for 30 days, or every 5 minutes if set up 
manually

Reveal (PCMD)

• Provides estimated device location using a Round Trip Delay 
measurement from the tower.  It IS NOT a GPS location of the device. 

• Available for approx. 2 weeks for data, and approx. 90 days for voice 
and SMS traffic.

• Time stamps are based on switch time. Sprint does not testify to the 
accuracy of these reports. 
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3

Sprint CDRs:
Lucent vs Nortel

1

2

3

120
240

0

2

34

Lucent
“lose the 1”

2 Alpha 
3 Beta 
4  Gamma

Nortel

1 Alpha 
2 Beta 
3 Gamma 

* Remember that cell 
sector orientations may 
vary tremendously 
depending upon your 
location. For that 
reason, you must check 
your tower list to 
determine the actual 
sector orientations for a 
tower. 

120
240

0

1

23

The Lucent rule applies to CDRs, not tower lists  
UNCLASSIFIED//LES
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CALLING_NBR CALLED_NBR DIALED_DIGITS M_R_# START_DATE END_DATE DURATION (SEC) NEID REPOLL_# 1ST CELL LAST CELL

(401) 602-5421 (401) 954-2401 Inbound 10/20/14 9:05:14 10/20/14 9:05:14 0 192 295 0 0

(401) 954-2401 (401) 602-5421 Outbound 10/20/14 9:06:30 10/20/14 9:06:30 0 195 517 0 0

(401) 954-2401 (401) 602-5421 Outbound 10/20/14 9:16:17 10/20/14 9:16:17 0 197 522 0 0

(401) 602-5421 (6245000) 000-0911 (401) 954-2401 Routed_Call 10/20/14 9:32:34 10/20/14 9:32:38 4 101 247 20286 20286

(401) 954-2401 (401) 602-5421 (401) 602-5421 Outbound 10/20/14 9:32:45 10/20/14 9:33:33 48 101 247 20286 20286

(401) 954-2401 (401) 741-5419 Outbound 10/20/14 9:38:18 10/20/14 9:38:18 0 196 294 0 0

(401) 741-5419 (401) 954-2401 Inbound 10/20/14 9:42:29 10/20/14 9:42:29 0 192 508 0 0

(401) 954-2401 (401) 741-5419 Outbound 10/20/14 9:42:50 10/20/14 9:42:50 0 197 532 0 0

(401) 419-3714 (401) 954-2401 (401) 954-2401 Inbound 10/20/14 9:49:52 10/20/14 9:50:16 24 101 247 20286 20286

(401) 954-2401 (401) 741-5419 741-5419 Outbound 10/20/14 9:56:04 10/20/14 9:56:35 31 101 247 20286 20286

(401) 602-5421 (401) 954-2401 (401) 954-2401 Inbound 10/20/14 9:58:46 10/20/14 9:59:26 40 101 247 20286 20286

(401) 602-5421 (401) 954-2401 (401) 954-2401 Inbound 10/20/14 10:06:50 10/20/14 10:07:04 14 101 247 20286 20286

(401) 954-2401 (401) 602-5421 Outbound 10/20/14 10:14:50 10/20/14 10:15:17 27 101 247 20197 20286

(401) 954-2401 (401) 741-5419 741-5419 Outbound 10/20/14 10:15:25 10/20/14 10:15:58 33 101 247 20286 20286

(401) 954-2401 (401) 602-5421 (401) 602-5421 Outbound 10/20/14 10:16:23 10/20/14 10:17:12 49 101 247 20286 20286

(401) 954-2401 (401) 602-5421 Outbound 10/20/14 10:17:19 10/20/14 10:17:37 18 101 247 20286 20286

(401) 954-2401 (401) 602-5421 Outbound 10/20/14 10:17:49 10/20/14 10:17:51 2 101 247 20286 20286

(401) 954-2401 (401) 741-5419 741-5419 Outbound 10/20/14 10:17:55 10/20/14 10:18:59 64 101 247 20286 20286

(401) 954-2401 (401) 741-5419 741-5419 Outbound 10/20/14 10:24:07 10/20/14 10:26:54 167 101 247 20286 20286

(401) 654-7176 (401) 954-2401 Inbound 10/20/14 10:35:33 10/20/14 10:35:33 0 192 294 0 0

(401) 654-7176 (401) 954-2401 Inbound 10/20/14 10:35:35 10/20/14 10:35:35 0 192 513 0 0
# placing 

(initiating) 
the call

Digits that the caller 
enters into the 
keypad of the 

phone

Mobile Role (Type of Call).  
Listed as outgoing, incoming, 
routed call or undetermined

Date and time 
the call was 

initiated

Date and time the 
call ended

Duration of call, 
in seconds

This reflects which 
network element 
handled the call

This reflects 
which switch 

handled the call

# actually 
called

Specific cell site in which the 
call was initiated. The first 

digit reflects the sector. The 
last 4 digits represent the site 

number

Specific cell site in which the call 
was ended. The first digit reflects 

the sector. The last 4 digits 
represent the site number

Sprint Call Detail Record
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Sprint CDR & Tower List



.79 miles

.79 miles

Search Area

• By using the data transfer rate between the cellular device and the tower, the cellular provider can approximate the signal 
distance between the tower and the cellular device using a Round Trip Delay measurement from the tower. 

• Time stamps are based on switch time. 
• Sprint does not testify to the accuracy of these reports. 
• Available for approx. 2 weeks for data and SMS traffic, and approx. 90 days for voice traffic.

Caution: Lat/Long coordinates are NOT GPS-based. The distance from tower information is generally more 
accurate. Sometimes the Lat / Long coordinates can be helpful.     

Engineering Data: PCMD 
(Per Call Measurement Data)

UNCLASSIFIED//LES

http://images.google.com/imgres?imgurl=http://andygreenhaw.files.wordpress.com/2009/07/sprint20logo201.jpg&imgrefurl=http://andygreenhaw.wordpress.com/2009/07/&usg=__TN1Hr0nD8QTpFcyLohtKoOAbWqk=&h=325&w=600&sz=94&hl=en&start=5&um=1&tbnid=4KxUWz0_-gpywM:&tbnh=73&tbnw=135&prev=/images?q=Sprint&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1
http://images.google.com/imgres?imgurl=http://andygreenhaw.files.wordpress.com/2009/07/sprint20logo201.jpg&imgrefurl=http://andygreenhaw.wordpress.com/2009/07/&usg=__TN1Hr0nD8QTpFcyLohtKoOAbWqk=&h=325&w=600&sz=94&hl=en&start=5&um=1&tbnid=4KxUWz0_-gpywM:&tbnh=73&tbnw=135&prev=/images?q=Sprint&hl=en&rlz=1T4SKPB_enUS347US348&sa=N&um=1


CDR and PCMD

NEID 1st Cell

Notice that the CDRs reflect sectors as 3 and 4, but the PCMD reflect sectors as 
2 and 3. Lucent rules only apply to CDRs (not PCMD)

Switch Cell # Distance
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1

2
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PCMD
Sample Mapping

425-340-2

425-145-3

1.07 miles

1.6 miles
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Ping

Lat: 39.95246
Long: -75.15158

• The GPS Ping is Sprint’s location based service offered to 
law enforcement. 

• A Ping is conducted with the assistance of the cellular 
provider.  A silent message is sent to the phone requesting 
a location update.  The phone uses its own GPS receiver 
and reports its location.

• The location accuracy is based upon the phone  interacting 
with a minimum of 4 satellites (3 without altitude).    
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T-Mobile

* On 5/13/2013, MetroPCS merged with T-Mobile.  Contact 

T-Mobile for all MetroPCS requests 

Contact Information:

Law Enforcement Relations Group (973) 292-8911

Fax (973) 292-8697

Email LERcourtorders@t-mobile.com

Address: T-Mobile Law Enforcement Relations Group
4 Sylvan Way
Parsippany, NJ 07054

Technology: GSM (2.5G), UMTS, LTE
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T-Mobile

Available 
Information

• With subpoena: subscriber, tolls, store video, device and payment info

• With court order: pen registers (no location)

• With search warrant: everything above, historic & real-time location, voicemail, 
customer notes/memos, wiretap

• Wifi may not show up on CDRs because they do not go through the cellular network

Length of Time 
Call Detail 
Records are 
Maintained

• Pre-paid accounts:  2 years from present date

• Post-paid accounts: since account was opened

SMS Records

• Billed information is available - i.e. date and time stamp of the text message

• No text message content is stored or available 

• Provides call and text tower/sector info

Location Based 
Services

• Assisted GPS (“WebMap”) to provide real-time, approximate location, $51 per day

• Note the sector orientation on towers can be very different, therefore, it is important to 
import sector, and sector orientation on historical location information

• WebMap will send an email at a desired time with lat/long & radius of uncertainty
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Engineering 
Data Sets

• Timing Advance/TDOA (“TrueCall”): T-Mobile historic location based service 

• Includes data registrations not just calls

Pen Registers
• $200 set-up fee and $20 per day maintenance with a minimum fee of $500 

• No extension fee if authorization provided prior to takedown

IP Data 
Sessions

• Cannot currently translate IPV4 addresses (ex. 152.138.17.240) to an 
actual phone number

• Can translate IPV6 addresses (example 
0001:0db8:0000:0042:0000:8a2e:0370:7334) to a phone number

Calls to 
Destinations 
Search

• Yes

• No current cost for Calls to Destination search

• Legal threshold - Subpoena or higher

Exigent 
Circumstances

• Use the T-Mobile form or call them and indicate that you have an exigent 
circumstance.  Then fax/email with agency letterhead. Exigent 
circumstances are generally honored for up to 48 hours.

T-Mobile
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“Such service provider shall initiate a signal to determine the location of the subject’s mobile 
device on the service provider’s network or with such other reference points as may be 
reasonably available and at such intervals and times as directed by the law enforcement agent 
serving this order”

All legal demands should include the following:

•Issued to or Commanded to search T-Mobile 

•Signature of legal authority who issued demand

•Signature Date

•Target to be searched

•Date Range

•Specific list of record(s) requesting 

•Return Information (fax, address, e-mail)

T-Mobile
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The latitude and longitude 

coordinates are emailed

* Note these are typically in Pacific time.  When using E-911 Locator, verify the timestamp.

T-Mobile E-911 Locator 
Email Sample
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T-Mobile E-911 
Responses

Response 1

• Location of [target phone #] date, time and lat / long and uncertainty

i.e. Location of [2157081214] at [6/04/2008 9:30:32 AM] 

Result: [Lat:39.937835 Lon: -75.177705 Uncertainty 443m]

Response 2 • [Absent_Subscriber] – phone is not on the network

Response 3

• [Position_Method_ Failure] – phone is powered off or has moved into an 
area where switch is not provisioned

**If you see this – it may come back on**

Response 4 • [Internal_ Error] – phone is on but roaming on another network

Response 5 • [System_ Failure] – phone has gone off network



T-Mobile CDR

T-Mobile Mediation Reports
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T-Mobile CDR
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T-Mobile CDR
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T-Mobile CDR- Data Sessions
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T-Mobile CDR 
& Tower List

Location Area Code Cell ID

• Each cell tower and cell site sector has a unique Cell ID  that is 
like a fingerprint and is not repeated anywhere in the network

You Must Use a Tower List From The Time The Crime Occurred

Location Area Code Cell_ID

Tower Azimuth

Orientation

UNCLASSIFIED//LES



T-Mobile CDR 
& Tower List

1st LTE Site ID

• Each cell tower and cell site sector has a unique Cell ID  that is 
like a fingerprint and is not repeated anywhere in the network

eNodeB_ID

1st Tower Azimuth

Azimuth

You Must use a tower list from the time the crime occurred

UNCLASSIFIED//LES



CID: 28506
No Sector 

Orientation

T-Mobile 
Tower List Sector Orientation

Sector Column
CID: 28501 or 11UAA: Sector 1, Carrier 1, UMTS, AWS, Macro
• Orientation shows “0” Degrees or North
CID: 28506 or 12UAA: Sector 1, Carrier 2, UMTS, AWS, Macro
• Orientation is blank, however it shares the same orientation as 11UAA. (0 Degrees or North

UNCLASSIFIED//LES
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• Switch pooling is a load sharing/load balancing system for T-Mobile   

• It causes Voice calls and SMS to be listed in time zones other than 

where the phone was located

• Confirm switch times are correct before analyzing data

• Switch pooling is a load sharing/load balancing 

system for T-Mobile   

• It causes Voice calls and SMS to be listed in time 

zones other than where the phone was located

• Confirm switch times are correct before analyzing 

data

Switch list

MSISDN Start Time Direction Connected To
First Tower LAC 

/ ENodeB_ID

First Tower 

Cell ID / 

ECGI_Cell

First Tower 

Latitude

First Tower 

Longitude

Last Tower 

LAC / 

ENodeB_ID

Last Tower 

Cell ID / 

ECGI_Cell

MSC Name

14014974972 10/20/2014 08:41:24 AM Outgoing 14013327364 36488 30986 41.84435 -71.43616 36488 30986 NVMSS319

14014974972 10/20/2014 08:55:26 AM Outgoing 2551683 36488 30986 41.84435 -71.43616 36488 30986 NVMSS319

14014974972 10/20/2014 09:16:22 AM Outgoing 14013239529 36488 30986 41.84435 -71.43616 36488 30986 NVMSS319

14014974972 10/20/2014 09:17:02 AM Outgoing 14014977620 36488 30986 41.84435 -71.43616 36488 30986 NVMSS319

14014974972 10/20/2014 09:32:21 AM Outgoing 14014977620 36488 32484 41.82957 -71.4436 36488 32484 NVMSS319

14014974972 10/20/2014 09:44:35 AM Incoming 14013452766 36488 32116 41.82428 -71.46816 36488 32115 NVMSS319

14014974972 10/20/2014 09:46:22 AM Outgoing 14014414663 36488 31584 41.80799082 -71.4535027 36480 31581 NVMSS319

14014974972 10/20/2014 09:47:48 AM Incoming 14014414663 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 09:50:25 AM Incoming 14013980555 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 09:55:09 AM Incoming 14013452766 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 09:55:39 AM Incoming 14015563719 NA NA NA NA NA NA

14014974972 10/20/2014 09:56:01 AM Outgoing 14014414663 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:11:12 AM Outgoing 14014977620 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:12:35 AM Outgoing 14014414663 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:13:59 AM Outgoing 14019526215 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:14:46 AM Outgoing 14019542401 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:22:37 AM Incoming 14014977620 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

14014974972 10/20/2014 10:28:56 AM Outgoing 14016321739 36488 31586 41.80799082 -71.4535027 36488 31586 NVMSS319

Switch ID MSC/IAP MSC Location

NVMSS969 14044558020 Nashville 

NVMSS319 14044558021 Nashville 

NVMSS930 14044558038 Nashville 

NVMSS970 14044558022 Nashville 

NVMSS319 14044558021 Nashville 

T-Mobile Switch Pooling
Not in New Mediation Reports-

only in older records
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Switch Pooling Switch List

MSC starts with
MSC Location

(NOT TO BE INTERPRETED AS THE 
LOCATION OF THE DEVICE)

AT Atlanta

CH Chicago

CL Cleveland

CR Carolina

DA Dallas

DC Washington DC

DE Detroit

DN Denver

FL Miami

HI Honolulu

HN Houston

IE Inland Empire CA

IN Indianapolis

JK Jacksonville FL

KC Kansas City

LA Los Angeles

MN Minneapolis

NE New England

NO New Orleans

NV Nashville

NY New York

OR Orlando

PH Philadelphia

PR Puerto Rico

SC Sacramento

SE Seattle

SF San Francisco

SP Spokane WA

VG Las Vegas



Engineering Data: True Call
(Per Call Measurement Data)

UNCLASSIFIED//LES

Time Location Distance

This is a new report type for T-Mobile.  It is not yet available in all markets.
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Verizon

Verizon Wireless
180 Washington Valley Road

Bedminster, NJ 07921

Technology: CDMA & LTE

Contact Information:

Verizon Security Assistance Team (VSAT): Subpoenas, 
Surveillance, Court Orders, Exigent Situations

(800) 451-5242

FAX (Subpoenas) (888) 667-0028

FAX (Court Order/Search Warrant) (888) 667-0026

FAX (Surveillance) (800) 267-9129

FAX (Exigent) (800) 345-6720

Verizon Landline:

Security Control: Surveillance, Court Orders, Exigent
(800) 483-0722

Fax (800) 997-9981
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Verizon

How They Will 
Send Records

• Will provide a .csv file that can be imported into a Microsoft Excel file 
and email them to a secure law enforcement account, if requested

• Request a raw Real Time Tool (RTT) report for calls and data 
separately

Length of Time 
CDRs are 
Maintained

• Call detail record with cell site information available for a rolling 
calendar year (1 year from the present date)

• After this, records are expunged from the system

Location Based 
Services

• No current location based services besides cell site location, sector 
information, and timing advance, but they are working on creating a 
tool

Engineering Data 
Sets

• The tower/sector/distance report is called a RTT report and is usually 
available for approximately 8 days historical on a phone.

Length of Time 
Text Messages are 
Maintained

• Text messages are kept for approximately 7 days

• Cost for text message content (real time) – $50 every five days per 
target number

• Legal threshold – Search Warrant
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Verizon

Cost Per Pen 
Register

• $50 administrative fee

• $20 setup fee per switch (max $60)

• $400 monthly maintenance per target per switch

• $1,000 per target for 3 or more switches

Phrase to use in 
historical records 
orders/warrants

• “All available call detail records (CDR) to include SMS detail, data 
sessions, PCMD / RTT data, cell site and cell site sector information 
from (date) to present”

Calls to 
Destinations 
Search

• Available

• There is no current cost for Calls to Destinations Search

• Legal threshold- Subpoena

• Court Order or Search Warrant is required for Cell Sites



1

2

3

Verizon
Lucent vs Nortel

1

2

3

120
240

0

2

34

Lucent
“Lose the 1”
2 Alpha 
3 Beta 
4   Gamma

Nortel

1 Alpha 
2 Beta 
3 Gamma 

* Remember that cell 
sector orientations may 
vary tremendously 
depending upon your 
location. For that 
reason, you must check 
your tower list to 
determine the actual 
sector orientations for a 
tower. 

120
240

0

1

23

The Lucent rule applies to CDRs, not tower lists  
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Data Retention Periods
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Cell site sector of the 

initiated call.  Direction 

the target was facing the 

tower at the time of this 

call.  Each cell face is 

approx. 120 degrees.

Duration of the 

call in seconds

Cell site that the 

target phone was 

hitting off of when 

the call terminated

Exact date 

and time of 

the start of 

each call

This is the switching 

equipment that transacted the 

call.  A switch is named by the 

basic geographic area it 

covers.  Switches route calls 

for hundreds of cell sites.

The target #

# dialed to initiate the call.  

Inbound calls: this # will be the 

same as the Mobile Directory 

Number column.  Outbound calls: 

this is the # your target dialed.

Type of call

0 & 6: Inbound calls

F: Voicemail or forwarded calls

1 & 3: Outbound calls

2: mobile to mobile

Other #s: unknown call type

Site the target 

phone was 

hitting off of 

when the call 

initiated

Cell site sector 

of the 

terminating call

Calling party that initiated the 

call.  Outbound calls:  this # 

will be the same as the 

Mobile Directory # column, 

and will be the # that dialed 

the target.

Network Element Name Mobile Directory Number Dialed Digit Number Call Direction Seizure Dt Tm Seizure Duration First Serving Cell Site First Serving Cell Face Last Serving Cell Site Last Serving Cell Face Calling Party Number

Raleigh 9194526633 9197979151 1 1/1/2015 0:00 44 485 3 = Gamma 485 3 = Gamma 9194526633

Raleigh 9194526632 4049559052 1 1/1/2015 0:00 6 485 3 = Gamma 0 0 9194526632

Raleigh 9194526632 9197979150 1 1/1/2015 0:01 42 485 3 = Gamma 658 1 = Alpha 9194526632

Raleigh 9194526632 4045859128 1 1/1/2015 0:01 7 485 3 = Gamma 0 0 9194526632

Raleigh 9194526632 9194526632 F 1/1/2015 0:04 39 0 0 0 0 9195993282

Raleigh 9194526632 9194526632 F 1/1/2015 0:04 6 0 0 0 0 2027607421

Greensboro_MTX 9194526632 9197979150 5 1/1/2015 0:04 4 0 0 0 0 2027607421

Raleigh_MTX08 9194526632 4045859128 5 1/1/2015 0:04 14 0 0 0 0 9195993282

Raleigh 9194526632 9195993282 1 1/1/2015 0:05 108 475 1 = Alpha 464 3 = Gamma 9194526632

Raleigh 9194526632 9194526632 0 1/1/2015 0:11 33 464 3 = Gamma 616 1 = Alpha 9193583062

Raleigh 9194526632 9194526632 0 1/1/2015 0:29 97 464 3 = Gamma 464 3 = Gamma 9193583062

Raleigh 9194526632 9194526632 0 1/1/2015 0:39 45 464 3 = Gamma 464 3 = Gamma 9197979150

Raleigh 9194526632 9195194007 1 1/1/2015 1:06 266 464 3 = Gamma 616 1 = Alpha 9194526632

Raleigh 9194526632 4049559173 1 1/1/2015 1:06 7 464 3 = Gamma 0 0 9194526632

Raleigh 9194526632 9193583062 1 1/1/2015 1:11 43 464 3 = Gamma 464 3 = Gamma 9194526632

Raleigh 9194526632 4049559003 1 1/1/2015 1:11 7 464 3 = Gamma 0 0 9194526632

Verizon CDR
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Verizon CDR & Tower List



• Verizon Wireless offers a service known as the Real Time Tool. 
• This info is provided to law enforcement during exigent circumstances or if requested in a legal document.  
• Data exists for approximately 3-7 days
• Includes approximate distance from the tower

RTT (Real Time Tool) CDRs

Network Element Name
First Serving

Cell Site

* A Verizon CDR may represent LUCENT Sectors (2, 3, 4), but Verizon RTT will always 
represent Sectors (1,2,3) whether LUCENT or NORTEL

No Switch Name Int Cell Sector

First Serving
Cell Face

Access Distance (miles)
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RTT
Sample Mapping
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US Cellular

Legal Compliance Department
8410 Bryn Mawr Ave., suite 800, Chicago, IL 60631

subpoenacompliance@uscellular.com

Technology: CDMA, LTE, GSM (1 tower)

Contact Information:

Subpoena/Order/Warrant Group Phone
Phone (800) 333-4847

Fax (866) 669-0894 

After Hours Contact Info
Phone (630) 875-8270

Fax (865) 777-8333

• GSM Tower located in Northern Maine
• No LTE records are being provided currently
• Roaming Issues
• Only 2 compliance personnel

• Hex vs. Decimal

• PCMD in certain markets

• Cannot use CASTViz
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Where are they???
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Type of Records Provided & Retention time

Type of Information Description Retention Period

Call Detail Records

Details the outgoing and incoming phone numbers, captures 

date and time of calls. 1 rolling calendar year

Text Message Records

Details the outgoing and incoming phone numbers, captures 

date and time of text messages. 1 rolling calendar year

Content of Text Messages Captures the content of information sent via text. 3-5 days

Bill Reprints Reprint of customers billing statement. estimated 7 years

Cell Tower Information Tower information that call was processed through. 1 rolling calendar year

Subscriber Information

Name, address, social security number, equipment type, 

activation date and location of service activation. 

Estimated 7 years, depending 

on conversion

Payment History

Payment amounts, date payment made and source type ( i.e. 

credit card, check, IVR or cash). 1 rolling calendar year

Account Memos

Record of customer interaction with U.S. Cellular® front line 

associates.  From July 2013 to present
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US Cellular

How They Will 
Send Records

• Will email Excel (.xls) files to secure law enforcement accounts. Voice 
and SMS are provided in separate files.

CDRs (Voice)

• Available for 1 rolling calendar year.

• Includes incoming/outgoing completed and incomplete calls, calls 
routed to voicemail, and calls using multiple switches (Roaming calls 
must be requested from carrier handling the calls).

Location Based 
Services

• Does not have a real time locator tool service, but can ping phone in 
exigent circumstances per request.

• PCMD available in Roanoke (VA), Lynchburg (VA) and Morgantown 
(WV) markets only.

• Can provide Pen/TT records.

SMS Toll Records

• 1 rolling calendar year. Provided separately from voice CDRs.

• Includes sending and receiving information (e.g.: when the text was 
sent & when it was received, originating & terminating numbers, etc.). 

• Cell sites not provided

• SMS Content is available for 3-5 days
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SwitchCID (Hex) & Sector

• Current Tower Lists contain both HEX and DEC CLLI (aka, Tower 
and Sector).

CID (Hex) & Sector Switch
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